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Preface

This guide provides information about how to install Oracle Health Sciences Clinical 
Development Analytics (OHSCDA).

This preface contains the following topics:

■ Audience on page v

■ Documentation Accessibility on page v

■ Finding Certification Information on page vi

■ Change Record on page vi

■ Related Documents on page vi

■ Conventions on page vii

Audience
This installation guide is intended for users who are responsible for installing Oracle 
Health Sciences Clinical Development Analytics. You must be familiar with:

■ Oracle Database

■ Oracle Analytics Server (OAS)

■ Oracle Business Intelligence Data Warehouse Administration Console (DAC)
application

■ Informatica PowerCenter application

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.



vi

Finding Certification Information
Certifications provide access to product certification information for Oracle and third 
party products. A product is certified for support on a specific release of an operating 
system on a particular hardware platform. For certification information, see Oracle 
Health Sciences Applications Supported Technology Stack (Doc ID 180430.1) on My Oracle 
Support (https://support.oracle.com).

Change Record

March 2020: Second version of the guide. In this version:

■ Oracle Database version 19c (19.3.0.0.0) has been certified.

■ Oracle Business Intelligence Data Warehouse Administration Console version has
been upgraded from 11.1.1.6.4 to 11.1.1.7.0.

■ Informatica PowerCenter version has been upgraded from 10.2.0 to 10.4.0.

■ Added instructions to grant "CREATE JOB" to "dest_schema_owner" has been
added in Section 2.1.4.2, "Destination Consolidation Database Configuration".

■ Removed information on applying OBIEE patches 26725930 and 27311972

October 2022: Third version of the guide. In this version:

■ Oracle Database version 19c (19.15.0.0.0) has been certified.

■ Oracle Analytics Server version 5.9 has been certified.

Related Documents
For more information, see the following documents in the Oracle Business 
Intelligence Data Warehouse Administration Console, Oracle Analytics Server, Oracle 
Clinical, Siebel Clinical, and Oracle Health Sciences InForm documentation sets.

Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
Documentation
The Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
documentation set includes: 

■ Oracle® Fusion Middleware User's Guide for Oracle Business Intelligence Data
Warehouse Administration Console

■ Oracle Business Intelligence Data Warehouse Administration Console Installation,
Configuration, and Upgrade Guide

July 2019: First version of the guide.

October 2023: Fourth version of the guide. In this version:

■ Oracle Database version 19c (19.20.0.0.0) has been certified.

■ Oracle Analytics Server version 7.0 has been certified.

January 2024: Fifth version of the guide. In this version:

■ Oracle Database version 19c (19.21.0.0.0) has been certified.

■ Informatica PowerCenter version 10.5.4 has been certified.

https://support.oracle.com
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■ Oracle Analytics Migrating and Upgrading to Oracle Analytics Server

■ Oracle Analytics Administering Oracle Analytics Server

■ Oracle Analytics Managing Metadata Repositories for Oracle Analytics Server

■ Oracle Analytics Managing Security for Oracle Analytics Server

Oracle Clinical Documentation
The Oracle Clinical documentation set includes: 

■ Oracle Clinical Administrator's Guide

■ Oracle Clinical Getting Started

■ Interfacing from Oracle Clinical

■ Oracle Clinical Conducting a Study

■ Oracle Clinical Creating a Study

■ Oracle Clinical Installation Guide

Siebel Clinical Documentation
The Siebel Clinical documentation set includes: 

■ Siebel Data Model Reference for Industry Applications

■ Siebel Life Sciences Guide

Oracle Health Sciences InForm Documentation
The Oracle Health Sciences InForm documentation set includes:

■ Oracle Health Sciences InForm Upgrade and Migration Guide

■ Oracle Health Sciences InForm Installation Guide

■ Oracle Health Sciences InForm Study and Reporting Setup Guide

■ Oracle Health Sciences InForm User Guide

■ Oracle Health Sciences InForm Reporting and Analysis

■ Oracle Health Sciences InForm Utilities Guide

■ Oracle Health Sciences InForm Clinical Data API Guide

■ Oracle Health Sciences InForm Reporting Database Schema

■ Oracle Health Sciences InForm Secure Configuration Guide

■ Oracle Health Sciences InForm Third Party Licenses and Notices

Oracle Analytics Server (OAS) Documentation
The Oracle Analytics Server Online Documentation Library documentation set 
includes: 

■ Oracle Analytics Designing and Publishing Pixel-Perfect Reports in Oracle Analytics
Server

■ Oracle Analytics Using Oracle Analytics Publisher in Oracle Analytics Server

■ Oracle Analytics Visualizing Data in Oracle Analytics Server

■ Oracle Analytics Installing and Configuring Oracle Analytics
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1Before You Begin

This section presents an overview of the Oracle Health Sciences Clinical Development 
Analytics (OHSCDA) requirements. It also describes the tasks that you must complete 
before you can install the application.

This chapter includes the following sections:

■ Section 1.1, "Checking for the Most Recent Information"

■ Section 1.2, "Technology Stack and System Requirements"

■ Section 1.3, "Installing the Prerequisite Software"

1.1 Checking for the Most Recent Information
OHSCDA documentation is updated periodically. Therefore, it is critical that you 
check that you have the most current information before you begin the installation 
process.

To ensure that you have the most recent version of this Installation and Configuration 
Guide, and all other OHSCDA user documentation, see 
https://docs.oracle.com/cd/F19319_01/index.htm.

1.2 Technology Stack and System Requirements
The requisite technology stack for OHSCDA configuration consists of the following 
products:

■ Oracle Database 19.21.0.0.0

■ Oracle Fusion Middleware 12c (12.2.1.4.0) Infrastructure

■ Oracle Analytics Server (OAS) 7.0

■ Oracle Business Intelligence Data Warehouse Administration Console 11.1.1.7.0

■ Informatica PowerCenter 10.5.4

https://docs.oracle.com/cd/F19319_01/index.htm
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Installation Considerations
■ Determine the computer on which you will install each component of OHSCDA.

■ You may select to install each product on a different server, if required. The
OHSCDA media pack server does not have to act as server for any of the products,
though it may. You may consult Figure 1–1, and the documentation listed in
Table 1–1 for information on installing each product.

■ Determine the databases you need to create.

■ You must create a database schema to serve as the warehouse for OHSCDA.

■ It is a good practice to create the schema for the OHSCDA warehouse in a new
database.

■ You may select to create schemas for repositories for the other OHSCDA
components in the same database that will be used for the OHSCDA warehouse. It
minimizes the number of databases that you need to maintain for OHSCDA.
However, if you will be using the component applications for purposes other than
OHSCDA, Oracle recommends that you create their repositories in instances other
than the one holding the OHSCDA warehouse.

Note: Technology stack components are not part of the media pack. 
You must acquire their license separately.

All references to media pack server in this document refer to the system 
onto which you download the media pack for Oracle Health Sciences 
Clinical Development Analytics.

Make sure that the domain information of the Informatica repository, 
where you plan to import OHSCDA related Informatica mappings, is 
added to domains.infa file of the Informatica client.

Table 1–1  System Requirements References

Product Reference

Oracle Database 19.21.0.0.0 Database Installation Guide for <platform>

Oracle Fusion Middleware 12c (12.2.1.4.0) Infrastructure Oracle Fusion Middleware Documentation Library

Oracle Analytics Server (OAS) 7.0 System Requirements and Supported Platforms for Oracle Analytics 
Server

Oracle Analytics Installing and Configuring Oracle Analytics

Oracle Business Intelligence Data Warehouse 
Administration Console 11.1.1.7.0

Oracle Business Intelligence Data Warehouse Administration Console 
Installation, Configuration, and Upgrade Guide

Data Warehouse Administration Console User's Guide

Informatica PowerCenter 10.5.4 Informatica PowerCenter Installation Guide

Note: It is important to get the technology stack products from the 
OHSCDA media pack because newer versions of the technology stack 
products may have become available but may not be compatible with 
OHSCDA.
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Figure 1–1 Oracle Health Sciences Clinical Development Analytics Technology

1.2.1 Supported Web Browsers
OHSCDA supports web browsers that are supported by OAS. For the list of the 
browsers supported by OAS, refer to Administering Oracle Analytics Server  for Oracle 
Analytics Server Edition 7.0.

1.2.2 Source Systems
OHSCDA is designed to extract data from the following three systems:

■ Oracle Clinical (OC) 5.2 and 5.4

■ Siebel Clinical Trial Management System (SC) 8.1.1.17, 8.1.1.18, 22.4,  and 23.11

■ Oracle Health Sciences InForm 4.6, 5.5, 6.0, 6.1.0, 6.1.1, 6.2.0, 6.3.0, 6.3.1, 6.3.1.1, 
and 7.0

1.3 Installing the Prerequisite Software
Figure 1–2 displays a sample topology of the technology components for OHSCDA.

Note: For information on Oracle Software Web Browser Support 
Policy, see Doc ID 2092205.1 on My Oracle Support 
(https://support.oracle.com).
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Figure 1–2 Sample Topology

Before you can install the OHSCDA application, you must complete the following 
pre-installation tasks:

■ Install Oracle Database 19.21.0.0.0.

Follow the instructions in Oracle Database Installation Guide for <platform>.

Also, install Oracle Database Client for 19.21.0.0.0 on the system where you are 
running the OHSCDA installer. Follow the instructions in Oracle Database 
Client Installation Guide for <platform>.

■ Install Oracle Analytics Server 7.0 with the following components:

– Oracle Fusion Middleware 12c (12.2.1.4.0) Infrastructure (Supported on
Windows and Unix)

– Oracle Analytics Server 7.0 (Supported on Windows and Unix)

– Oracle Analytics Client Tools (Supported only on Windows)

Follow the instructions in Oracle Analytics Installing and Configuring Oracle 
Analytics Server.

■ Install Oracle Business Intelligence Data Warehouse Administration Console
(DAC) 11.1.1.7.0

Follow the instructions in Oracle Business Intelligence Data Warehouse Administration
Console Installation, Configuration, and Upgrade Guide.

Note: You must set the init parameter processes for the database to a 
minimum of 500.
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■ Install Informatica PowerCenter 10.5.4
Oracle recommends that you create Informatica repository for OHSCDA with the

following settings:

You must add the AggSupprtWithNoPartLic property in Informatica PowerCenter 
Administration Console, to use the sorted Aggregator transformation set in 
Informatica PowerCenter.

Perform the following steps to add the AggSupprtWithNoPartLic property:

1. Log on to Informatica PowerCenter Administration Console.

2. Select the PowerCenter Integration Service.

3. In Custom Properties, click Edit.

4. Click Add.

5. Enter AggSupprtWithNoPartLic in the Name field.

6. Enter Yes in the Value field.

7. Click OK to add the property.

For more information, see Informatica PowerCenter Installation Guide.

■ If you implement multi-byte character support for OHSCDA, set the following:

– Operating System Level: Ensure that the system that hosts Informatica and
Database have the following parameters set:

* NLS_LANG=AMERICAN_AMERICA.AL32UTF8

* LANG=en_US.UTF-8

– Database Level: Ensure that the following parameters are set while creating
database:

* NLS_CHARACTERSET =AL32UTF8

* NLS_NCHAR_CHARACTER= AL16UTF16

– Informatica Level: Oracle recommends that you create Informatica integration
service for OHSCDA with the following settings:

Table 1–2  Informatica Repository Settings

Settings Value

Character Set UTF8

Versioning True

Global Repository False

Security Audit Trail No

Operating Mode Normal

Table 1–3  Informatica Integration Service

Settings Value

Character Set UTF8

Versioning True

Global Repository False
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■ Informatica Workflow Relational Connection: For all relational connection in
Informatica (Datawarehouse, Inform_Source, Oracle_Clinical, and Siebel_Clinical),
set:

– Connection Environment SQL to "alter session set NLS_LENGTH_SEMANTICS
= 'CHAR';

– Code Page to UTF-8 encoding of Unicode

Security Audit Trail No

Operating Mode Normal

DataMovementMode Unicode

Code Page UTF8

Table 1–3 (Cont.) Informatica Integration Service

Settings Value

 Oracle Health Sciences Clinical Development Analytics Installation and Configuration Guide for Informatica
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2Installing Oracle Health Sciences Clinical 
Development Analytics

This chapter describes the OHSCDA installation tasks that you must complete.

OHSCDA application installation consists of the following components:

■ Adding InForm Studies to the OHSCDA Warehouse

■ Set Up Siebel Clinical Replication Schema

■ Running the OHSCDA Installer

■ Source-specific Procedures

■ Setting Up Relational Connections in the Informatica Workflow for OHSCDA

■ Preparing a DAC Repository for OHSCDA

■ Emplacing the OHSCDA Help Files

■ Preparing the OAS Web Catalog and Repository for OHSCDA

■ OAS Post-deployment Configuration

■ Configuring Maps

■ Creating Security Groups for OHSCDA

2.1 Adding InForm Studies to the OHSCDA Warehouse

Figure 2–1 displays the OHSCDA InForm consolidation installation scenarios.

Note: You must perform the tasks in this section only if:

■ You have InForm as a source

■ It is a fresh installation of OHSCDA

■ Inform_Consolidate.zip and Inform_Consolidate_on_prem.zip
files are part of the OHSCDA installer. Run installer for target data
warehouse to get access to the files from installer home.
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Figure 2–1 OHSCDA InForm Consolidation Installation Scenarios

2.1.1 OHSCDA InForm Consolidation Schema
This section describes how OHSCDA extracts InForm's operational data and loads it 
into the OHSCDA warehouse. All of the data for each InForm study is maintained in a 
transactional database (actually a database schema). InForm maintains one or more 
InForm databases per Oracle database instance. Each study also has a Reporting and 
Analysis database (again, a set of objects in a schema, not necessarily an exclusive 
database instance) which contains data in views designed for query, as opposed to 
transactional activity.

Inform maintains the Reporting and Analysis database for each study in a 
study-specific schema. For efficiency and maintainability, OHSCDA has created a 
program that extracts data from a number of InForm Reporting and Analysis 
databases and places that data into a single consolidated database. Then, OHSCDA's 
source-dependent extract code reads from the consolidated database, and writes to the 
OHSCDA warehouse.

For the remainder of this section, refer to any given InForm Reporting and Analysis 
database as a source schema and the schema in which OHSCDA consolidates InForm 
data as the consolidation schema.

OHSCDA consolidates data from selected InForm source schema views, the selected 
ones being the ones that have data corresponding to columns in the OHSCDA data 
model. The following are the InForm source views that are consolidated for OHSCDA:

■ IRV_AF_SUBJECT_FORMS

■ IRV_CUR_QUERY

■ IRV_CUR_RULE

■ IRV_CUR_SITE

Note: You can download the OHSCDA patch from My Oracle 
Support (https://support.oracle.com).
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■ IRV_CUR_SPONSOR

■ IRV_CUR_SUBJECT

■ IRV_CUR_USER

■ IRV_FORM_REVS

■ IRV_ITEMSET_REVS

■ IRV_ITEM_REVS

■ IRV_QUERY_STATE_CHANGES

■ IRV_SECTION_REVS

■ IRV_STUDYVERSIONS

■ IRV_STUDYVERSION_FORMS

■ IRV_STUDYVERSION_VISITS

■ IRV_SUBJECT_STATE_CHANGES

■ IRV_SV_SUBJECTVISITS

■ IRV_USERS_SITES

For each of these source views, the consolidation schema contains a consolidation 
table. Each consolidation table has the same columns as its source view, except that the 
consolidation table has three additional columns:

■ STUDYGUID

■ CONSOLIDATION_DATETIME

■ MODIFIEDDATETIME

STUDYGUID is needed to retain the association of each record with its InForm study. 
CONSOLIDATION_DATETIME and MODIFIEDDATETIME allows OHSCDA ETL to 
detect which consolidated records have been added or updated since the prior ETL 
execution.

The names of tables in the consolidation schema match the names of their source 
views, with the following change:

■ IRV in the source view name is replaced with RXI in the consolidation table name.

Consolidation is the process of getting new or modified records from a source schema 
and updating the consolidation schema with those records. Consolidation is carried 
out by periodic execution of a scheduled job in each InForm schema that contributes to 
the consolidation schema. Execution is done through the DBMS_JOB facility. Each 
source schema is consolidated on its own schedule.

There is no master job that oversees or coordinates the consolidation of all the source 
InForm schemas. You can choose to consolidate different InForm schemas at different 
times, and with different intervals between consolidations. However, the more spread 
out consolidations are, the wider the time period represented by the records in the 
consolidation schema. So it is recommended that you schedule consolidation jobs to 
fall within a small time window. For details on scheduling, see Section 2.1.6, 
"Adjusting Scheduling of Consolidation Jobs".

When the Consolidation job executes for a particular source schema, it does the 
following:

For each source table from which OHSCDA extracts data,



Adding InForm Studies to the OHSCDA Warehouse

2-4 Oracle Health Sciences Clinical Development Analytics Installation and Configuration Guide for Informatica

■ Identify what records have been created or modified in this table since the
previous consolidation

■ For each modified source record, drop the corresponding record in the
consolidation table

■ Insert all new and modified records in the Consolidation schema table, setting
their StudyGUID, and modification timestamps

The procedures that does this work reside in each InForm Reporting and Analysis 
Schema, they are placed there as part of the process of preparing that schema for 
consolidation.

Preparation for consolidation also creates an access account in the database holding 
the source schema. This account is the one that reads the Reporting views, and writes 
to the consolidation tables. This access account is named CDAxxx, where xxx is the 
Study name.

All movement of data is done by a pull from the Reporting and Analysis Database to 
the Consolidation database. This ensures that there is no path by which someone who 
can connect to the consolidation schema is able to modify the InForm database.

The instructions that follow tell how to do the initial setup of the consolidation schema 
(this also enrolls the first Study to be consolidated as part of the process) and then how 
to set up each additional InForm study so that it becomes a contributor to the 
Consolidation schema.

2.1.2 Prerequisites

1. Copy Inform_Consolidate.zip for InForm cloud or Inform_Consolidate_on_
prem.zip for InForm on premise from <OCDA_HOME>\OCDA_
ODI\Database\DWH_Scripts\OCDA_Common_Scripts directory.

2. Copy and unzip the Inform_Consolidate.zip file to a server from which it is
possible to access all InForm source database that contain studies that are to be
consolidated and also to access the database in which the consolidation schema is
located.

2.1.3 Setting up Consolidation Schema
This section describes the steps to create the Consolidation Schema. As part of the 
process, it enrolls an initial InForm study as a source to be consolidated.

2.1.3.1 Preparing TNSNAMES Files on Source Trial and Destination Consolidation 
Database Servers
If one does not already exist, create a TNSNAMES.ORA entry for the Consolidation 
database instance on each InForm database server that contains a study that is to be 
consolidated. 

■ On the consolidation schema database server, add a TNSNAMES.ORA entry for
each source schema database.

Note: This is not essential. If you prefer not to create the 
TNSNAMES entries, you can provide the complete connection string 
instead of the TNS name when specifying remote databases below.
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2.1.3.2 Creating a Consolidation Management Root Directory
■ On consolidation schema database server, create a root directory for managing the

files needed to configure and log consolidation of the source schemas.

We will refer to this directory as <$ConsolidationMgmtRoot>.

If source trial and destination consolidation databases are in the same network, then a 
single <$ConsolidationMgmtRoot> is sufficient. Else, replicate the directory in both 
the servers.

During the setup of the source trial database, use TrialCDA and logs folders. And, 
during the setup of the destination consolidation database, use DestCDA and logs 
folder.

2.1.4 Initiating Consolidation of InForm Studies
This section describes the steps you must follow to prepare a source schema for 
consolidation and perform the initial execution of consolidation of that schema. 
Subsequent consolidations occurs automatically at an interval you define as part of the 
preparation described here.

The setup and configuration is performed in the following two phases for each study 
trial:

■ Section 2.1.4.1, "Source Trial Database Configuration"

■ Section 2.1.4.2, "Destination Consolidation Database Configuration"

2.1.4.1 Source Trial Database Configuration
Follow the instructions in this section for each InForm study that is to be consolidated 
for consumption by OHSCDA.

1. On either source trial or destination consolidation schema database server, based
on the network architecture as described in Section 2.1.3.2, "Creating a
Consolidation Management Root Directory", create the <Study-name> folder
within <$ConsolidationMgmtRoot>/ to hold the files for consolidation of this
study.

2. Copy the following folders from Inform_Consolidate.zip into
<$ConsolidationMgmtRoot>/<Study-name>/:

■ TrialCDA

■ Logs

3. Set your current directory to the
<$ConsolidationMgmtRoot>/<Study-name>/TrialCDA/ directory.

4. Edit CONFIGTRIALCDA.sql to set specific values of configuration parameters for
this study. Make the following changes:

Table 2–1  Source Trial Configuration Parameters

Parameter Set value to

Slash Use \ for Windows or / for Linux

trial_name The name of the study.

inform_release For InForm release 4.6, enter R46.

For InForm releases 5.5 to 6.2.x, enter R55.

For InForm release 6.3 onward, enter R63.
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5. Save the file.

6. From the SQLPlus prompt, execute the following:

@Setup_Trial_CDA.sql

7. Navigate to the <$ConsolidationMgmtRoot>/<Study-name>/Logs directory to
review the log.

If any errors are found, make necessary corrections and re-execute Setup_Trial_
CDA.sql.

2.1.4.2 Destination Consolidation Database Configuration
Follow the instructions in this section for each InForm study that is to be consolidated 
for consumption by OHSCDA.

1. On the consolidation schema database server, based on the network architecture as
described in Section 2.1.3.2, "Creating a Consolidation Management Root
Directory", create the <Study-name> folder within <$ConsolidationMgmtRoot>/
if the destination consolidation database is not in the same network as the source
trial database.

The <Study-name> folder holds the files for consolidation of this study.

2. Copy the following folders from Inform_Consolidate.zip into
<$ConsolidationMgmtRoot>/<Study-name>/:

trial_tnsname Name in the local TNSNAMES file of the source 
database for the study. Can also supply entire TNS 
entry for the source database as a string.

trial_schema_user Username of the InForm source schema.

trial_schema_password Password of the InForm source schema.

trial_ro_user This is OHSCDA reporting object schema user name 
and is defaulted to trail_name prefixed with 'cda'.

trial_ro_password This is OHSCDA reporting object schema password 
and is defaulted to trail_name prefixed with 'cda'. 
You can change this password.

DDS_SCHEMA_OWNER This is OHSCDA reporting object schema user name. 
This value must be same as the value you have 
entered for trial_ro_user.

trial_dba_user Database username who has the dba privileges.

trial_dba_password Password for database username.

trial_ts Name of a tablespace in the source schema database 
to which the access account for this study will be 
given access.

trial_ts_temp Name of a temporary tablespace in the source 
schema database to which the access account for this 
study will be given access.

Note: Do not copy the Logs folder if the destination consolidation 
database is in the same network as the source trial database.

Table 2–1 (Cont.) Source Trial Configuration Parameters

Parameter Set value to
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■ DestCDA

■ Logs

3. Set your current directory to the
<$ConsolidationMgmtRoot>/<Study-name>/DestCDA directory.

4. If you use Oracle Database 19c as the destination consolidation database, provide
additional grant "CREATE JOB" to "dest_schema_owner":

a. Open the Setup_Dest_CDA.sql file.

b. Navigate to the section "Prompt Creating the trial schema user account in the
Destination database.."

c. Replace execute immediate ' grant CREATE VIEW, CREATE TABLE ,ALTER
SESSION ,CREATE SESSION '

with

execute immediate ' grant CREATE JOB,CREATE VIEW, CREATE TABLE
,ALTER SESSION ,CREATE SESSION '

d. Save the file.

5. Edit CONFIGDESTCDA.sql to set specific values of configuration parameters for
this study. Make the following changes:

The trial parameters mentioned in Table 2–2 must match with the ones defined in 
Table 2–1.

Note: If you prefer not to create the TNSNAMES entries, you can 
provide the complete connection string instead of the TNS name when 
specifying the remote databases below.

Table 2–2  Destination Configuration Parameters

Parameter Set value to

Slash Use \ for Windows or / for Linux

Parameters for configuring the source schema and database

trial_name The name of the study.

inform_release For InForm release 4.6, enter R46.

For InForm releases 5.5 to 6.2.x, enter R55.

For InForm release 6.3 onward, enter R63.

trial_tnsname Name in the local TNSNAMES file of the source 
database for the study. Can also supply entire TNS 
entry for the source database as a string.

trial_schema_user Username of the InForm source schema.

trial_global_name Global name of the source schema database. You can 
get this by connecting to the source schema and 
running the following query:

SELECT * FROM GLOBAL_NAME

trial_ro_user This is OHSCDA reporting object schema user name 
and is defaulted to trail_name prefixed with 'cda'.
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6. Save the file.

7. From the SQLPlus prompt, execute the following:

@Setup_Dest_CDA.sql

8. Navigate to the <$ConsolidationMgmtRoot>/<Study-name>/Logs directory to
review the log.

If any errors are found, make necessary corrections and re-execute Setup_Dest_
CDA.sql.

2.1.5 Creating InForm Auto Merge Tables
If InForm is one of the source systems, connect to the InForm Consolidation database 
and execute the cda_cdb_automerge_ddl.sql script located in the <OCDA_
HOME>/oracle.pharma.ocda.standard/OCDA_Common_Scripts/DataModels 
directory.

trial_ro_password This is OHSCDA reporting object schema password 
and is defaulted to trail_name prefixed with 'cda'. 
You can change this password.

Parameters for configuring the target schema and database

dest_tnsname Name of the target database in the TNSNAMES file 
on the source database server for the study. Can also 
supply entire TNS entry for the target database as a 
string.

dest_schema_owner This defaults to and is same as trial_ro_user 
parameter.

dest_schema_password This defaults to and is same trial_ro_password 
parameter.

dest_consolidated_user This is the consolidation schema username. Default is 
RXI_INFORM.

dest_consolidated_password This is the consolidation schema password. Defaults 
is RXI_INFORM. You can change this password.

dest_dba_user Database username who has dba privileges on the 
consolidation database.

dest_dba_password Password for the database username on the 
consolidation database.

dest_ts Name of a tablespace in the target schema database 
to which the consolidation and access account will be 
given access.

dest_ts_temp Name of a temporary tablespace in the target schema 
database to which the consolidation and access 
account will be given access.

consolidate_job_interval The interval between executions of the program to 
consolidate new and modified data from this study. 
A value of 1 results in an interval of one day. A value 
of 1/24 results in an interval of one hour.

Table 2–2 (Cont.) Destination Configuration Parameters

Parameter Set value to
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2.1.6 Adjusting Scheduling of Consolidation Jobs
As mentioned earlier, initial consolidations, especially of large source schemas, should 
be done in isolation to avoid contention for resources. But once the initial 
consolidation of a schema is done, subsequent consolidations of that schema are 
incremental and involve smaller numbers of records (incremental consolidations are 
limited to new or modified Subjects, CRFs, and Queries accumulated since the 
previous consolidation).

Once initial consolidation of an InForm trial source schema is complete, it is useful to 
adjust the scheduling of its incremental consolidations so that they start near to the 
time of other incremental consolidation of other source schemas. The closer in time 
consolidations start across studies, the smaller the time period represented in the 
consolidation schema. 

To adjust the time when a study's consolidation job executes, perform the following 
steps:

1. Connect as the InForm trial source schema owner.

2. Determine the consolidation job ID using the following query for InForm 4.6:

select job
from user_jobs
where what like 'REFRESH_PROCS.REFRESH_WITH_STREAMS_DELAY%';

or the following query for InForm release 5.5 and later:

select job
from user_jobs
where what = 'CDA_PROCS.CONSOLIDATE';

3. Change the time for the next execution of the job by using the dbms_job.next_date
procedure.

Remember to follow the call with a commit. For example,

begin
dbms_job.next_date (
  job => 12345,
  next_date => to_date('21-AUG-2013@01:01:00','DD-MON-YYYY@HH24:MI:SS')
);
end;
commit;
/

This causes job 12345 to next be executed at 1:01 AM on 21-AUG-2013.

You can also change the interval between subsequent executions of the job using the 
dbms_job.interval procedure. Set the interval parameter to the string 'SYSDATE + 
<desired-interval>', replacing <desired-interval> with the number of days, or the 
fraction of a day to elapse before the next execution.

begin
dbms_job.interval(
  job => 12345,
  interval => 'SYSDATE + 1/2'
);

Note: The next_date parameter is an Oracle date-time in which you 
can specify both the date and time for the next execution.
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end;
commit;
/
This sets the interval between executions of job 12345 to half a day or every 12 hours.

2.2 Set Up Siebel Clinical Replication Schema
If you have Siebel Clinical on cloud and OHSCDA on premise, replicate the Siebel 
Clinical tables on premise. To do so, replicate the OHSCDA Siebel Clinical source by 
performing the following steps:

1. Copy the CDA_Source_Replication.zip from <OCDA_HOME>\OCDA_Common_
Scripts directory to your folder.

2. Unzip CDA_Source_Replication.zip.

3. Navigate to DestCDA folder.

4. Open CONFIGDESTCDA.sql, and set value for parameters mentioned in
Table 2–3.

Table 2–3  Parameters in CONFIGDESTCDA.sql

Parameter Set value to...

Slash Use \ for Windows or / for Linux.

Parameters related to source schema and database

trial_name Name of the study or source type. For example, SIEBEL.

application_release The source application release version.

instance_guid Numeric unique ID for the source instance that will be replicated.

This is added as a record qualifier for each record that is replicated in 
the target schema.

incr_date_col The date column on source tables that are used to identify incremental 
data load.

For example:

For Siebel Clinical, the date column is "DB_LAST_UPD".

trial_tnsname Name in the local TNSNAMES file of the source database for the 
study/source. You can also provide the entire TNS entry for the 
source database as a string.

trial_global_name The global name of the source schema database. You can get this 
name by connecting to the source schema and running the following 
query:

SELECT * FROM GLOBAL_NAME

trial_schema_user Username of the source schema that holds the actual transactional 
tables.

trial_ro_user The source read only user name that is created on the trial schema 
user to provide read only access.

If your source is not protected by Read Only user, provide the actual 
source schema name (trial_schema_user) and its password.

Parameters for configuring the target schema and database

dest_tnsname Name of the target database for the study in the TNSNAMES file 
located on the source database server. You can also provide the entire 
TNS entry for the target database as a string.

dest_schema_owner The stage user where the data is processed.

dest_consolidated_user The consolidation schema username. For example, RXI_SC.

dest_dba_user The database username who has database administrator privileges on 
the consolidation database.
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5. Open command prompt and navigate to CDA_Source_Replication\DestCDA.

6. Connect to SQL*Plus.

sqlplus /nolog

7. Execute the script:

@Setup_Dest_CDA.sql

8. Enter passwords in the prompts that appear.

This will setup the infrastructure for the data replication schemas.

9. If you want to replicate additional tables:

a. Connect to dest_schema_owner.

b. Create an entry for the additional table in the "CDA_CONSOLIDATED_
TABLES" table.

c. Commit the changes.

10. In SQL*Plus, execute the script:

@Setup_Dest_CDA_Load.sql

11. Enter passwords in the prompts that appear.

The execution log is created in the CDA_Source_Replication\Logs directory.

2.3 Running the OHSCDA Installer
The basic OHSCDA components are installed using the Oracle Universal Installer. The 
installer gathers all the information about the database connectivity, data mart, 
Informatica repository by presenting a sequence of prompt screens and then installs 
the components accordingly.

Perform the following steps to install the OHSCDA application on Windows:

1. Extract the contents of the media pack into a temporary directory (For example,
C:\ocda_temp).

dest_ts Name of a tablespace in the target schema database to which the 
consolidation and access account will be given access.

dest_ts_temp Name of a temporary tablespace in the target schema database to 
which the consolidation and access account will be given access.

consolidate_job_interval The interval between executions of the program to consolidate new 
and modified data from the source system. A value of 'freq=hourly; 
INTERVAL=1' results in an interval of one hour.

This parameter is similar to DBMS_SCHEDULER  parameter repeat_
interval. You can provide input as per the standards of the package. 
For more information, see 
https://docs.oracle.com/database/121/ARPLS/d_
sched.htm#ARPLS72261.

Important: Make sure that both the Oracle Database client and the 
Informatica client are available on the same system where you plan to 
execute the installer.

Table 2–3 (Cont.) Parameters in CONFIGDESTCDA.sql

Parameter Set value to...
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2. Navigate to the \install directory under the extracted temporary folder.

3. Double-click the setup.exe file to launch the Oracle Universal Installer with the
Welcome screen.

The installer will take you through a series of screens having fields. Attend to the
Installer’s prompts. The following sections describe each Installer screen, and the
required action.

The Welcome screen provides information about the Oracle Universal Installer.

4. Click Next.

The Specify Home Details screen appears.

5. Enter the name of the installation and path where all the staged files from the
Installer get copied to the local system. This is also the location from where
Installer executes the database script.

Example Name: OCDAHome1

Path: C:\OCDA

6. Click Next.

The OCDA Data Warehouse Details screen appears.

7. Enter values in the following fields:

■ Database Host Name

■ Database Port No

■ Database Service Name

■ System Password

■ Default Tablespace Name

■ Temporary Tablespace Name

■ Enable National Language Support (NLS)?

8. Click Next.

9. Enter values in the following fields:

■ OCDA Warehouse Schema (RXI) Password

■ OCDA Warehouse Schema (RXI) Confirm Password

■ OCDA RPD (RXI_RPD) Password

■ OCDA RPD (RXI_RPD) Confirm Password

10. Click Next.

The Informatica PowerCenter Details screen appears.

11. Enter values in the following fields:

■ Informatica Repository Name

■ Informatica Domain Name

Note: The password must be alphanumeric and can contain only "_" 
or "#" special character.
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■ Informatica Host Name

■ Informatica Repository Port Number

■ Informatica Username with Admin Privileges

■ Informatica Password for Admin User

■ Confirm Informatica Password for Admin User

12. Click Next.

The Informatica PowerCenter Client Home Directory screen appears.

13. Specify Informatica PowerCenter client Home directory. For example:
C:\Informatica\10\clients\PowerCenterClient\client

14. Click Next.

15. Verify the details provided in the Summary screen.

16. Click Install.

2.4 Source-specific Procedures
This section describes procedures you must perform for certain OHSCDA sources. 
Please review each section and determine if it applies to the source(s) you are using for 
OHSCDA. If the section does apply, carry out the procedure. If the section is optional, 
decide whether it is appropriate for your requirements and act accordingly.

2.4.1 Handling Deletions of Source Records
Different source applications handle the deletion of records in different ways. Oracle 
Clinical allows deletions of records in a way that avoids orphans, and has built-in 
auditing of these deletions. Siebel Clinical also allows deletions, properly cascading to 
maintain referential integrity, but does not have built-in auditing of deletions. InForm 
does not provide any means to hard-delete records in its transactional database. So, it 
does not need to be concerned neither with maintaining integrity in the face of 
deletions nor with auditing deletions.

2.4.1.1 Handling Deletions in Oracle Clinical
OHSCDA's ETL consults the audit trails to determine if source records have been 
deleted, and then soft-deletes those records in the warehouse.

2.4.1.2 Handling Deletions in Siebel Clinical

OHSCDA provides a feature to manage hard deletion of records in Siebel Clinical. 
Create triggers in the source system to handle deletion of records.

1. Navigate to the following temporary staging location where the OHSCDA
installer copies the installation files:

< OCDA_HOME>\Delete_Script

2. Connect to the Siebel Clinical schema and run the ocda_sc_del_trigger.sql
script delivered with OHSCDA. This script creates the triggers on tables provided

Note: You must record the log file path that appears on the bottom of 
the screen for future reference.
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as input. The following are the tables in Siebel Clinical for which OHSCDA 
supports creating triggers:

■ S_CL_PTCL_LS

■ S_PROD_INT

■ S_CL_SUBJ_LS

■ S_CONTACT

■ S_CL_PGM_LS

■ S_PTCL_SITE_LS

■ S_EVT_ACT

■ S_ORG_EXT

■ S_PTCL_VER_LS

■ S_ASSESS

Provide a list of comma separated values of table names for which the triggers 
need to be created as the script's input. For example, S_CL_PTCL_LS, S_PROD_
INT, and S_CL_SUBJ_LS. The tables names that you provide can only be a subset 
of the tables listed above.

3. Set DAC source system parameter DELETE_FLOW value to Y before running
Execution plan.

4. Execute the ETLs. For information, see Oracle Clinical Development Analytics
Administrator's Guide.

The Siebel Clinical related SDE mappings read the above instance of the RXI_
DELETE_LOG_S table.

2.4.1.3 Handling Deletions in InForm
Since no deletions are supported through the InForm UI, OHSCDA makes no 
provision for detecting them. If you need to delete records from an InForm 
transactional table at the backend and want the OHSCDA warehouse to be consistent 
with that change, you must identify the warehouse records that arose from the InForm 
records that are to be deleted. Also, you must remove them from the consolidation 
schema and the warehouse.

2.4.2 (Optional) Handling Deletion or Deactivation of a Study
Depending on how you use OHSCDA, you may prefer to have reports that give 
information only on currently active studies. If so, and if source studies are completed 
or possibly deleted, the recommended approach for removing such a study from 
OHSCDA is to use OHSCDA's access control capability. That is, enable Study and 
Study-site access controls, and then exclude the study and its sites from the list of 

Note: When you delete a record in the table, the primary key of the 
deleted record is inserted in the RXI_DELETE_LOG_S table on the 
Siebel source system.

Note: Records that are deleted in the source system are soft deleted 
in the data warehouse.
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studies (and sites) available to OHSCDA users. Aside from being simpler than 
identifying and deleting records from the warehouse, this approach has the advantage 
of being reversible if the decision to remove the study from the warehouse is 
reconsidered.

If you do not wish to use access control to avoid display of deactivated or deleted 
studies, there is an alternative solution. In the OHSCDA warehouse, every dimension 
table, and every base fact table, has a column named DELETE_FLG. OHSCDA's OAS 
repository is designed to treat records where DELETE_FLG equals 'Y' as if they were 
not present in the warehouse. OHSCDA's SIL also disregards records with 
DELETE_FLG = 'Y' when calculating values for aggregate tables (those with names 
ending with _A). So you can cause records to be effectively removed from the 
warehouse by setting their DELETE_FLG to 'Y'. Thus, if a study has been removed 
from a source database, you could identify all dimension and fact records for that 
study, and set their DELETE_FLG to 'Y'. This causes them to be forever invisible to 
OHSCDA's analytics.

This solution could be used, but only with great caution, for a study that is considered 
to be deactivated, but still remains in the source. Once marked as deleted, warehouse 
records for a study will not get their DELETE_FLG set back to 'N', but OHSCDA 
creates new warehouse records if there are changes or additions in the source for that 
study. So, if the study is truly inactive in the source, soft-deleting warehouse records 
for the study by setting DELETE_FLG to 'Y' will work. But any changes or additions to 
the study would cause new records to be loaded into the warehouse for the study, and 
it would re-appear in analyses.

2.4.3 (Optional) Fine-tuning of Oracle Clinical Settings
To optimize source system integration with OHSCDA, perform the following steps:

1. For OC 5.2, navigate to Informatica Relational Connections > OC Connection
Object > Attribute in Informatica Workflow Manager.

2. Set Connection Environment SQL value as:

■ For Oracle Database 11.2.0.2:

alter session set optimizer_features_enable='11.2.0.2'

■ For Oracle Database 11.2.0.3:

alter session set optimizer_features_enable='11.2.0.3'

■ For Oracle Database 11.1.0.7:

alter session set optimizer_features_enable='11.1.0.7'

3. Create the following indexes on their respective Oracle Clinical tables:

■ Function based index on DISCREPANCY_ENTRIES - NVL
("MODIFICATION_TS", "CREATION_TS")

■ Function based index on DISCREPANCY_ENTRY_REVIEW_HIST - NVL
("NEXT_STATUS_TS", "CREATION_TS")

■ Function based index on RECEIVED_DCIS - NVL ("MODIFICATION_TS",
"RECEIVED_DCI_ENTRY_TS")

■ Function based index on RECEIVED_DCMS - NVL ("MODIFICATION_TS",
"RECEIVED_DCM_ENTRY_TS")
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2.5 Setting Up Relational Connections in the Informatica Workflow for 
OHSCDA 

For each database that will be a source for extracting data into the OHSCDA 
warehouse, perform the following steps to create a Relational Connection in the 
Informatica Workflow Manager:

1. Launch the Informatica PowerCenter Workflow Manager.

2. Connect to the repository where OHSCDA Informatica mappings are imported.

3. Select Connections, and then select Relational to display the Relational
Connection Browser.

4. Click New to display the Select Subtype dialog.

5. Select Oracle as database type, and then click OK. The Connection Object
Definition dialog box is displayed with options for the selected database platform.

6. Enter values in the following fields according to the Source database connection:

■ Connection Name: Enter the logical connection name.

■ User Name: Enter the user name that can access source data (For example,
rxa_des for Oracle Clinical.)

■ Password: Enter the database password.

■ Connection String: Enter the Connect string for connecting to the database.

■ Code Page: Enter UTF-8 encoding of Unicode.

2.6 Preparing a DAC Repository for OHSCDA

1. Create a new DAC repository, as an Administrator.

2. Unzip OCDA_HOME\oracle.pharma.ocda.standard\DAC_Code\CDA_
Warehouse.zip onto the computer where you will run DAC client.

3. Import the OHSCDA Warehouse Application metadata.

a. Start the Data Warehouse Administration Console (DAC) client.

b. From the Tools menu select DAC Repository Management, and then select
Import.

c. Click Change import/export folder to navigate to the folder where you
unzipped CDA_Warehouse.zip in step 2 of this section.

d. Click OK to display the Import dialog box.

Note: These values will also be required in setting up DAC. Make 
note of them to ensure that you enter the same during DAC setup.

The TNS entry for all your source and target databases must be added 
on Informatica Server.

Note: You must repeat steps 1 through 4 for each required source 
connection.
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e. Select the following categories of metadata you want to import: Logical,
Overwrite log file, and User Data. Deselect the User and System check boxes.

f. Select CDA_Warehouse application in the ApplicationList.

g. Click OK.

h. Enter the verification code and click Yes in the secondary window that is
displayed after the import.

i. You can inspect the import log in ${DAC_ INSTALL_DIR}\log\import.log to
verify if import is successful.

4. Configure Informatica Repository Service in DAC.

a. Navigate to the Setup view, and then select the Informatica Servers tab.

b. Click New to display the Edit tab below or select an existing Informatica
server from the list.

If you are configuring a new installation, the Informatica Servers tab will be
empty. If you are upgrading an existing installation, the Informatica Servers
tab might contain existing Informatica servers.

c. Enter values in the following fields:

- Name: Enter the Logical name for the Informatica server (for example,
INFA_REP_SERVER).

- Type: Select Repository.

- Hostname: Enter the host system name where Informatica Server is installed.

- Server Port: Enter the port number of the Informatica Server or Informatica
Repository Server used to listen to requests.

- Login: Enter the Informatica user login for the Admin user.

- Password: Enter the Informatica Repository password.

- Repository Name: Enter the Informatica Repository Name.

d. Test the connection to verify the settings.

e. Click Save to save the details.

5. Configure Informatica Integration Service in DAC.

a. Click New to display the Edit tab below or select an existing Informatica
server from the list.

If you are configuring a new installation, the Informatica Servers tab will be
empty. If you are using an existing installation, the Informatica Servers tab
might contain existing Informatica servers.

b. Enter values in the following fields:

- Name: Enter the Logical name for the Informatica server (for example,
INFA_SERVER).

- Type: Select Informatica.

Note: Make sure that you use the same Login and Password that you 
have used in setting up Informatica.
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- Service Name: Enter the Informatica Integration service name associated
with the Informatica repository added in Step 5.

- Domain: Enter the Informatica domain name.

- Login: Enter the Informatica Repository user login (Admin User).

- Password: Enter the Informatica Repository password.

- Repository Name: Enter the Informatica Repository Name.

c. Test the connection to verify the settings.

d. Click Save to save the details.

6. Configure source databases (Oracle Clinical, Siebel Clinical, and InForm) and the
target database (the OHSCDA warehouse). For each database with which DAC
will interact for OHSCDA, perform the following steps:

a. Navigate to the Setup view, and then select the Physical Data Sources tab.

b. Click New to display the Edit tab below or select an existing database
connection from the list.

c. Enter values in the following fields:

- Name: Enter the logical name for the database connection.

- Type: Select Source when you create the database connection for a
transactional (OLTP) database. Select Warehouse when you create the database
connection for a data warehouse (OLAP) database.

- Connection Type: Select a connection type for the database connection.

- Service Name: Enter the Data Mart database service name.

- Table Owner: Enter the Data Mart schema name.

- Table Owner Password: Enter the Data Mart schema password.

- DB Host: Enter the Data Mart host name.

- Port: Enter the Data Mart host port.

- Dependency Priority: Enter the user-defined priority of the data source.

- Data Source Number: Enter the user-defined number of the data source.
Make sure the number is less than 100.

- Num Parallel Indexes Per Table: Enter a number to specify how many
indexes are to be created in parallel.

d. Test the connection to verify the settings.

e. Click Save to save the details.

Note: By Default, Oracle supports Data Source Number 1, 2, and 3 
for Oracle Clinical, Siebel Clinical, and InForm respectively.

The logical Names of the connections in DAC must be same as the 
connection names created in Informatica Workflow Manager.

OHSCDA Warehouse connection must be the same as provided 
during OHSCDA installation.
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7. Perform the following steps to modify the value for data sources:

a. Navigate to the Execute view, and then select the Execution Plans tab.

b. If Oracle Clinical, Siebel Clinical, and InForm are your source systems, select
CDA - Complete Warehouse from the list.

If Oracle Clinical is your only source system, select CDA - Oracle Clinical
Warehouse from the list.

If Siebel Clinical is your only source system, select CDA - Siebel Clinical
Warehouse from the list.

If InForm is your only source system, select CDA - InForm Warehouse from
the list.

c. Click Connectivity Parameters subtab in the bottom pane.

d. For each row with TYPE equal to DATASOURCE, in the Value field, select the
appropriate Physical Data Source Name from the drop-down list for the field.

e. Select a relevant value from the list for each of the data sources.

f. Click Save.

Table 2–4  Sample of Data Source Table W_RXI_DATASOURCE_S

ROW_
WID

DATASOURCE
_NUM_ID

DATASOURCE_
NAME

DELETE_
FLG INTEGRATION_ID

ENTERPRISE
_ID INFORM_STUDY_GUID 

1 1 ORACLE_
CLINICAL

N ORACLE_
CLINICAL

0 -

2 2 SIEBEL_
CLINICAL

N SIEBEL_CLINICAL 0 -

3 3 INFORM N INFORM 0 {FA5BCD87-B858-4F08-8BF
8-1914B61C9DDF}

4 101 INFORM_1 N INFORM_1 0 {CC0DBD73-FA40-4943-BD
B3-60752C1A2732}

Note: If InForm is one of your sources and auto merge feature is not 
used, then the column INFORM_STUDY_GUID must be populated 
with studyguid for the corresponding InForm study.

You can find the distinct studyguid from table RXI_STUDYVERSIONS 
in the consolidation database.

From DAC, the value passed for the data source parameter is always 
3. Since we have one consolidation DB which holds all study data, the
guid, when auto merge is set to N, helps resolving individual data
source numbers.

If auto merge is set to Y, then a single entry for data source 3 for 
INFORM is sufficient and INFORM_STUDY_GUID need not be 
populated. In this case, the consolidation DB is considered as single 
source and duplicates are handled by auto merge.
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If you are installing DAC on the Windows Server 2012 R2, you must  and edit the 
config.bat under DAC home and set JAVA_HOME to installed JRE home.

1. Install a separate JRE.

2. Go to the <DAC_Home>\dac directory.

3. Edit the config.bat file to set JAVA_HOME to the installed JRE home.

2.6.1 DAC Configurable Parameters
Navigate to Design View and select CDA_Warehouse container from drop down. On 
Source System Parameters tab set values as mentioned in Table 2-4.

Table 2–5 lists the DAC configurable parameters.

Note: 

■ If Oracle Clinical, Siebel Clinical, and InForm are your source
systems, use CDA - Complete Warehouse.

■ If Oracle Clinical is your only source system, use CDA - Oracle
Clinical Warehouse.

■ If Siebel Clinical is your only source system, use CDA - Siebel
Clinical Warehouse.

■ If InForm is your only source system, use CDA - InForm
Warehouse.

Table 2–5  DAC Configurable Parameters

Parameter Description

START_TS This is the last refresh time of the source tables minus prune 
days. (@DAC_SOURCE_PRUNED_REFRESH_
TIMESTAMP)

END_TS Current Execution Plan’s actual start time adjusted to source 
database time zone minus prune days. (@DAC_ETL_
START_TIME_FOR_SOURCE)

DATASOURCE_NUM_ID The ID associated with every source system. The default ID 
is 1 for Oracle Clinical, 2 for Siebel Clinical, and 3 for 
InForm.

ENTERPRISE_ID The ID associated for every tenant. The default value is 0.

DELETE_FLOW The default value is N and set it to Y if Deletes have to be 
captured in the data warehouse.

EMAIL_SUFFIX You can provide domain name as a suffix to username. For 
example: oracle.com

Prune Days This is used for setting the END_TS for incremental load.

MPI_AUTHFILE Currently, not in use.

MPI_USER Currently, not in use.

AUTO_MERGE_FLG This is used to enable or disable auto-merge.

■ Y: Enables auto-merge

■ N: Disables auto-merge

$OutputFile_OCDA Currently, not in use.



Emplacing the OHSCDA Help Files

Installing Oracle Health Sciences Clinical Development Analytics 2-21

2.7 Emplacing the OHSCDA Help Files 
You will be using the help.zip file in this section.

2.7.1 Placement of Files for Oracle WebLogic Managed Server
If the OAS Server is not the same machine where the installer is run, copy the 
help.zip file to the machine where OAS server is installed. The help.zip file is located 
in the <OCDA_HOME>\Reporting\Help directory.

1. Extract the help.zip file at any location on the OAS Server. For example,
/scratch/stage/help.
The extracted help folder contains the analyticsRes folder.

2. Launch Oracle WebLogic Administration Server Console. The following shows the

format of the URL:

https://<hostname>.<domain>:<port>/console

The Oracle WebLogic Server Administration Console screen appears.

3. Log on to Oracle WebLogic Server Administration Console as an administrator.

4. In the left pane of the Administration Console, select Deployments.

5. In the left pane, click Lock & Edit.

6. In the right pane, click Install, and navigate to the location where help.zip was
extracted in step 1.

7. Select analyticsRes and click Next.

8. Select Install this deployment as an application and click Next.

9. In the Available targets for analyticsRes section, under Clusters, select bi_server1
on which you want to deploy OHSCDA.

10. Click Next.

11. Select the I will make the deployment accessible from the following location
option, and select the path for analyticsRes. For example,
/scratch/stage/help/analyticsRes.

12. Click Finish.
The analyticsRes appears in the Deployment table.

13. Click Activate Changes.

14. Click the Control tab.

15. Select analyticsRes in the Deployment section.

16. Click Start, and select Servicing all requests.
The Start Application Assistant page appears.

$DBConnection_SP_OLAP Currently, not in use.

$DBConnection_OLAP Currently, not in use.

Table 2–5 (Cont.) DAC Configurable Parameters

Parameter Description
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17. Click Yes to start the selected deployment.
The analyticsRes state becomes active after this deployment. You may confirm the
same on Deployments page.

18. Log out from Oracle WebLogic Server Administration Console.

19. Log on to Oracle Enterprise Manager Fusion Middleware Control. The following

shows the format of the URL:
https://<hostname>.<domain>:<port>/em

20. Restart the BI components.

21. Log on to OAS and verify the help links on the dashboards.

2.8 Preparing the OAS Web Catalog and Repository for OHSCDA

1. Stop the BI services.

2. To import the ssi.bar file, run the following command in [DOMAIN_HOME]/bi/

bitools/bin:

Importarchive.sh ssi <Location of the Bar file> encryptionpassword=<RPD

Password>

Where, encryptionpassword is the password used to encrypt the database connection 

credentials in the RPD. If not provided the connection credentials will not be imported.

For example:

importarchive.sh ssi /scratch/Software/OCDA/ssi.bar

encryptionpassword=Admin123 for linux

importarchive.cmd ssi C:\scratch\Software

\OCDA\ssi.bar encryptionpassword=Admin123 for windows



Preparing the OAS Web Catalog and Repository for OHSCDA

Installing Oracle Health Sciences Clinical Development Analytics 2-23

3. Restart the BI services.

4. Copy the OCDA.rpd file from <OCDA_HOME>\Reporting\RPD to the location
where the BI Administration tool is available.

5. In the Oracle BI Administration Tool, select File, then Open, and then Offline.

6. Navigate to the OCDA.rpd file, and then click Open.

Password: Admin123

7. Click OK.

8. In the Oracle BI Administration Tool, select File, and then select Change
Password.

9. Enter the current (old) password.

10. Enter the new password and confirm it.

11. Click OK.

12. Modify the connection pools in the RPD as following:

a. In the physical layer, expand the OCDA Data Warehouse node and
double-click the Connection Pool object.

The Connection Pool dialog box appears.

b. In the following string under the Data source name field, replace <hostname>,
<port_number>, and <SID_NAME> with the host name, port number, and
SID name of the database:

(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<port_
number>))(CONNECT_DATA=(SID=<SID_NAME>)))

c. Change the username to the username of the OHSCDA read-only DW RPD
schema name.

d. Change the password to the password of the OHSCDA read-only DW RPD
schema password.

e. Click OK.

f. Reconfirm the password.

g. Click OK.

h. In the physical layer, expand the OCDA Data Warehouse node and
double-click the OCDA_CP_InitBlocks object.

i. Repeat steps b through g.

13. From the File menu, select Save to save the rpd.

14. Click Yes for Do you wish to check global consistency?

15. Click Close in the Consistency Check Manager.
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16. Click Save.

17. Click File and then click Close.

18. Click File and then click Exit.

19. To upload the OCDA.rpd file, run the following command:
<Oracle_Home>\user_projects\domains\bi2\bitools\bin\datamodel.cmd uploadrpd -I OCDA.rpd

-W <RPD Password> -SI ssi -U <WebLogic Admin Username> -P <WebLogic Password> -S

<Server.Domain> -N <Listener Port>

20. Open the Fusion Middleware Control URL from the system where you saved the OCDA.rpd
in step 13. The URL includes the name of the host and the port number assigned during the
installation. The following shows the format of the URL: https://
<hostname>.<domain>:<port>/em

The login page appears.

Note: Oracle recommends that you enable HTTPS on middle-tier 
computers that are hosting the Web services, since otherwise the 
trusted user name and password that are passed can be intercepted.

2.9 OAS Post-deployment Configuration

1. Log in to EM (https://<hostname>.<domain>:<port>/em).
2. Navigate to Security > Application Policies.
3. Select Application Stripe as "obi", Principal Type as "Application role", and click on the 

right turned triangle icon.
4. Select BIAdministrator in the Principal pane and click on the Edit icon.
5. Under Permissions, click on the Add icon.
6. Click Resource Types.
7. Select Resource Type as "oracle.bi.tech.visualanalyzer.permission".
8. Click on right turned triangle icon.
9. Select Resource Name as "oracle.bi.tech.visualanalyzer.admin.access" and click Continue.
10. Select Permission Actions check box to "All" and click Select.
11. Under Permissions, click on the Add icon.
12. Click Resource Types.
13. Select Resource Type as "oracle.bi.pod.administration.permission".
14. Click on right turned triangle icon.
15. Select Resource Name as "oracle.bi.pod.admin.properties.edit" and click Continue.
16. Select Permission Actions check box to "All" and click Select.
17. Click OK and exit the page.
18. Restart the entire stack for the changes to take effect.
19. Open http://host.domain:port/analytics/systemsettings/
20. Search for "EVALUATE SUPPORT LEVEL" and change the value to 2.
21. Search for “Show Null Value When Column Is Nullable " and by default, it has "always" 

selected. Select "never".
22. Save the changes.
23. Click Restart in the upper right pane.



Creating Security Groups for OHSCDA

Installing Oracle Health Sciences Clinical Development Analytics 2-25

2.11 Configuring Maps
This section assumes that you installed Oracle BI Enterprise Edition and that Oracle 
MapViewer was automatically configured and deployed. For information on 
MapViewer, see Oracle Fusion Middleware User's Guide for Oracle MapViewer.

To administer maps using Administration pages:

1. Log in to OAS.
Make sure you have been granted the Access to Administration and Manage Map
Data privileges.

2. In the global header, click Administration.

3. Click the Manage Map Data link to display the Manage  Map Data page.

4. Click the Layers tab.

5. Click Import Layers  to display the Import Layers dialog.

a. In the dialog box, select ORACLE_MAPS from the Preview Map drop-down
list.

b. Select OracleMaps from the Look in drop-down list.

c. In Available Layers, select World_Cities.

d. Click OK.

e. Repeat steps a to d, but in step c for Available Layers, select World_Countries.

This will populate two entries in layers table.

6. Highlight and select World_cities in layers, and click Edit.

a. In Edit layer dialog box, select Layer key as City name from the drop-down
list.

b. In BI Key columns, click on the "+" icon, and select OCDA subject area in
select subject area pop-up.

c. In selected BI columns pop-up, expand study site folder, and select city.

d. Use ">" button to select the column, click OK, and again click OK to close
main dialog box.

e. Highlight and select World_countries in layers, and click Edit.

f. In Edit layer dialog box, select Layer key as Name from the drop-down list.

g. In BI Key columns, click on the "+" icon, and select OCDA subject area in
select subject area pop-up.

h. In selected BI columns pop-up, expand study site folder, and select country.

i. Use ">" button to select the column, click OK, and again click OK to close
main dialog box.
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5. In the Create a New Group page, provide the following information:

■ Name: Enter the name of the group. Group names are case insensitive but
must be unique. See online help for a list of invalid characters.

■ (Optional) Description: Enter a description.

■ Provider: Select the authentication provider from the list that corresponds to
the identity store where the group information is contained.
DefaultAuthenticator is the name for the default authentication provider.

6. Click OK.

The group name is added to the Groups table.

7. Repeat step 4 through 6 with the following values:

Table 2–6  Security Group Parameters

Name Description Provider

OCDA-CRA (Optional) DefaultAuthenticator

OCDA-DataManager (Optional) DefaultAuthenticator

OCDA-ExecutiveManager (Optional) DefaultAuthenticator

OCDA-RegionManager (Optional) DefaultAuthenticator

OCDA-StudyManager (Optional) DefaultAuthenticator

OCDA-WebcatAdim (Optional) DefaultAuthenticator

2.12 Creating Security Groups for OHSCDA
Perform the following steps to create groups:

1. Launch Oracle WebLogic Server Administration Console.

2. In Oracle WebLogic Server Administration Console, select Security Realms from
the left pane and click the realm you are configuring. For example, myrealm.

3. Select Users and Groups tab, then Groups.

4. Click New.

After you have specified background maps, layers, and zoom levels, MapViewer 
creates a static image for a map using this information. Then, MapViewer sends that 
image for rendering in the browser for use by content designers and end users in map 
views.

Note: This content will be lost if you reimport bar.

7. Click OK when you have finished selecting layers that are appropriate for the subject area
with which you are working.

8. Click the Background Maps tab, and click Import Background Maps to display the Import
Background Map dialog.

9. In the dialog, select ORACLE_MAPS for Available Maps.

10. Click OK when you have finished selecting main maps.

11. On the Background Maps tab, select a map, and click Edit Background Map to display the
Edit Background Map dialog in which you name the map and specify the order of layers and
their zoom levels preferably 6.

12. Click OK when you have finished editing the map.

13. Click Back when you have finished working with the Administration page. Your changes
are saved automatically.
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